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Abstract: Mine scheduling requires input variables such as geological model and economic values in order to
deliver an optimal production schedule. Geological uncertainty in grades, metal and material types cause a
difference in the performance of forecasted long-term production scheduling. The risk analysis of a production
schedule given geological uncertainty assists the potential performance of robust mine planning and risk
management. The Risk Analysis Tool (RAT) uses as input the mine production schedule and the set of
stochastic simulations of the mine deposits. The workshops show how the risk analysis is carried out using
the available RAT in COSMO Stochastic Mine Planning Laboratory. Data from a copper Martian mine is
used to describe the use of the software.
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1 Introduction

The purpose of the workshop is to show the use of Risk Analysis Tool v. 1.0.0 software (RAT) and perform

risk analysis for a given mine design and production schedule. It is hoped that following the workshop, the

user will be able to perform the risk analysis of any production schedule with multiple mines and multiple

destinations, and will be able to customize the risk profiles according to their needs. To date, RAT has

been tested successfully on 64-bit computers that have Windows XP or Windows 7 operating systems and

Microsoft Excel 2007 or Microsoft Excel 2010. Note that RAT does not operate on a 32-bit machine and

larger models with more than 20 orebody simulations will require a computer with more than 4GB RAM

and 1 GB available hard drive space.

An executable file RATsetup.exe is included in the installation package of Risk Analysis Tool v. 1.0.0. The

installation will start by simply double clicking RATsetup.exe. Click the Next button in the first copyright

panel then choose in the second panel where the application will be installed (e.g., C:\McGill COSMO\Risk

Analysis Tool\) and click the Next button. Confirm the installation by clicking the Next button once more

and a final panel should appear with a message that the installation is completed, see Figure 1.
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Figure 1: Second panel of the installation process Figure 1: Second panel of the installation process

When the installation process finishes, a new icon will be added on the desktop and the software Risk
Analysis Tool can be opened by double clicking this icon.
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The workshop for the Risk Analysis Tool is divided into four sections. The first section 

describes the input files required; the second, the third and the fourth sections are the 

sequence that a user must follow to perform risk analysis using RAT. 

 Input data. Explain the types of files and more specifically the information 

required for each input file. 

 Risk analysis model definition. Configure the parameters that describe the 

orebody, material type and destinations. Define the objectives for the risk profiles 

to address and the types of profiles to be generated. 

 Generating risk profiles. Read the previously defined parameters, generate risk 

profiles and save these risk profiles as output files. 

 Graphs of risk profiles. Display graphs and interpretation of risk profiles. 

RAT requires a set of parameters that define the risk analyses model; these parameters 

can be defined from scratch or can be loaded and modified from a saved parameter file. 

The parameters must be saved as an ASCII XML file, then the risk analysis utility is run 

by pressing on the Run button in the main window, see Figure 2.  

 

After clicking the Run button or executing the main routine, the parameters and the input 

data are read, the required risk profiles are generated and these risk profiles are saved. 

The workshop for the Risk Analysis Tool is divided into four sections. The first section describes the

input files required; the second, the third and the fourth sections are the sequence that a user must follow to

perform risk analysis using RAT.

• Input data. Explain the types of files and more specifically the information required for each input

file.

• Risk analysis model definition. Configure the parameters that describe the orebody, material type

and destinations. Define the objectives for the risk profiles to address and the types of profiles to be

generated.
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• Generating risk profiles. Read the previously defined parameters, generate risk profiles and save

these risk profiles as output files.

• Graphs of risk profiles. Display graphs and interpretation of risk profiles.

RAT requires a set of parameters that define the risk analyses model; these parameters can be defined

from scratch or can be loaded and modified from a saved parameter file. The parameters must be saved as

an ASCII XML file, then the risk analysis utility is run by pressing on the Run button in the main window,

see Figure 2.
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Figure 25: Generating the risk analysis outputs. 

The progress of the evaluation is reported in the Process Status box and any errors 

encountered will be reported as well. The utility progresses through six main stages: 

 Load the ore body models into memory. 

 Initialize the process or destinations. 

 Remove unnecessary information (filtering). 

 Evaluate the mine constraints. 

 Evaluate the process constraints. 

 Save the risk analysis outputs to a set of files. 

After clicking the Run button or executing the main routine, the parameters and the input data are read,

the required risk profiles are generated and these risk profiles are saved.
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Figure 2: Main window of Risk Analysis Tool v.1.0.0 software. 

Generating risk profiles is computer-intensive, particularly if the orebody are large with 

more than 20 stochastic simulations and the models involve multiple mines, that is, the 

main routine should be execute only one time unless additional risk profiles are required 

or an alternative mine design should be evaluated. Once the risk profiles are generated, 

the final step is to click the Show Result button in the main window.  

 

The workshop uses data from a copper mine to illustrate how to set the required 

parameter by RAT. The data are referred to as the Martian mine and contain a set of five 

geological simulations. Each simulation contains the copper grades (%), block tonnage, 

recoveries and material type.  

Given the type of material by block, there are a set of candidate destinations that the block 

can be sent to, see Figure 3. Each simulation also identifies the recovery (%) of the block if 

Figure 2: Main window of Risk Analysis Tool v.1.0.0 software

Generating risk profiles is computer-intensive, particularly if the orebody are large with more than

20 stochastic simulations and the models involve multiple mines, that is, the main routine should be ex-

ecute only one time unless additional risk profiles are required or an alternative mine design should be

evaluated. Once the risk profiles are generated, the final step is to click the Show Result button in the main

window.
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Figure 28: Section of risk analysis main window used to display risk profiles in Excel. 

The software will automatically load a table and create a chart into a new Excel sheet, see 

Figure 29.  

 

Figure 29: Risk analysis profiles displayed in Excel. 

The excel chart shows a risk profile graph similar to the graph in RA software. The user 

could use Excel tools to better customize the graphs.   

5.1 EXERCISE 3: graph Martian mine risk analysis profiles 

The Martian mine presents 5 material types and 5 destinations. The tones sent to each 

destination and the values that produce this decision were evaluated. 12 risk profiles were 

generated and will be displayed in Microsoft Excel, 5 profiles are linked with tones sent 
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The workshop uses data from a copper mine to illustrate how to set the required parameter by RAT. The

data are referred to as the Martian mine and contain a set of five geological simulations. Each simulation

contains the copper grades (%), block tonnage, recoveries and material type.

Given the type of material by block, there are a set of candidate destinations that the block can be

sent to, see Figure 3. Each simulation also identifies the recovery (%) of the block if it is sent to the given

destination. Along with the set of geological simulations, a production schedule file must be provided; this

file contains the coordinates of each mined block and the period that the block belongs to. The Martian mine

uses five material types, which are used to define the possible destinations. The material types are sulphide1,

sulphide2, mixed, oxides and waste, see Figure 3.
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RAT comes with five simulation files (SimMartian1.txt to SimMartian5.txt), a production 
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(MartianMCAF.txt) and an example of parameter configuration (Martian_Mine.xml) that 
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Figure 3: Material flow at Martian copper mine

All material types have the option of being sent to a waste dump, depending upon the value of the block.

The two sulfide groups can be sent to either of two mills, to waste, or to bio-leach pad. The mixed material

can either be sent to waste or to bio-leach pad and the oxide material can either be sent to waste or to acid

leach plant.

The Risk Analysis Tool requires at least two types of input files. One is the set of simulation files

and the second is a production schedule file. The installation package of RAT comes with five simulation

files (SimMartian1.txt to SimMartian5.txt), a production schedule file (MartianPhases.txt), a mining cost

adjustment factor file (MartianMCAF.txt) and an example of parameter configuration (Martian Mine.xml)

that is not essential when the parameters are set from scratch. These files can be found in the Data

folder, located where the software was installed (e.g., C:\McGill COSMO\Risk Analysis Tool\RiskAnalysis

Tools\Data).

2 Input Data

The input data is classified into two major categories: simulated and static. Simulated data is represented

by a set of files, within each file contains information relevant to the simulation of an orebody (i.e. metal

grade, material type, etc.) where the values for each block can vary from simulation-to-simulation. Static

data is a single file that contains information that remains constant, regardless of the simulation’s properties

(e.g. mining cost adjustment factor, phase design and production schedule).
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All the input data files must contain coordinates for each block in the ore body model. The input files

must also have a header row that describes the information in each column. Each row in the data file

should represent a different block (defined by its x, y, z coordinates). Note: The input data can not contain

duplicates of blocks in the same file, and can be either tab or space delimited between the columns. The user

should take the time to acquaint themselves with the data and classify the information before running the

program.

2.1 EXERCISE 1: Data classification

The user should make a table that describes each column of the input file, see Table 1. The availability of

this table and future tables around the workshop avoid mistakes through the model set. Also, a correct data

classification reduces the amount of memory required for the software. The input data is classified according

to the type of information it contains. The file is classified as Simulated or Static and each of its columns

will be a property that is organized as follows:

• Coordinates. These can be in either xyz format that represent mid block coordinate location or ijk

format that represent reference column, row and bench integer numbers. Once the format is chosen,

the format must be consistent throughout all data files.

• Material type. There must be one column that describes material types by each block for each

simulation file. The material type is described by integer numbers, e.g., 1 is waste, 2 is sulfide. The

material types are simulated because and varies through all orebody simulation input files.

• Important. This is any information that should be used in the risk analysis model and does not match

with existent property types. For example, element grades, simulated recoveries for each destination,

cost adjustment factors and block tonnages. These values can vary from simulation-to-simulation or be

static (remain constant) over all simulations.

• Mine design: only one mine design is evaluated with the provided risk analysis software. The mine

design must be stored in a separate file and classified as static data. The mine design input file is

mandatory to the software; otherwise, the risk profiles are not generated. If the user wants to evaluate

multiple designs, the software must be run for each mine design and perform independent analyses.

The user must figure out the time-scale for the mine design because the mine designs may be based

on quarterly or annual designs. The user must maintain a consistent time-scale in a multiple-mine

scenario. Note: The use of pushback for risk analysis of multiple-mine could be incorrect because one

pushback for one mine might take longer time to mine than a pushback from another mine.

Martian mine contains 5 scenarios of the orebody or simulation files. Generally, if the input file column

is not classified as coordinates property, material property or mine design property, the column is classified

as an Important property. The fourth column in Table 1 informs that some columns could be part of file

type simulated and others will be part of file type static; however, the coordinates are uploaded for both

simulated file type and static file type because the software needs to link each property with the location

of each block. Note: The coordinates of each block remain constant over all input files and only required

columns from input files could be uploaded.

Table 1 describes the columns contained in each of the simulation files and their classification.

The second input data that contain Martian mine correspond to the mine design that was saved in an

independent single file. The mine design or production schedule is stored in a file called Martianphases.txt.

Table 2 gives an overview of the data contained in the schedule file. The production schedule file is always

static data because the block will always be mined in the same period regardless of the geological scenario.

The third input data that contain Martian mine correspond to the mining cost adjustment factor that it

is found in the file MartianMACF.txt. See Table 3.

The input files should be located in the Data subfolder of the installation folder e.g., C:\McGill COSMO

Center\Risk Analysis Tool\RiskAnalysis Tools\Data. RAT assumes the Data folder as a working directory.
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Table 1: The contents of the orebody simulations files

Column # Column Name Meaning Files Type Property Type

1 XC Block’s X coordinate Static Coordinate – xyz – x
2 YC Block’s Y coordinate Static Coordinate – xyz – y
3 ZC Block-s Z coordinate Static Coordinate – xyz – z
4 MAT TYPE Material code Simulated Material
5 TONNES Block tonnage Simulated Important
6 TOTCU Block copper grade (%) Simulated Important
7 RECM1 Mill #1 recovery (%) Simulated Important
8 RECM2 Mill #2 recovery (%) Simulated Important
9 RECBL Bio-leach recovery (%) Simulated Important
10 RECOX Oxide leach recovery (%) Simulated Important

Table 2: The contents of the production schedule file

Column # Column Name Meaning Files Type Property Type

1 XC Block’s X coordinate Static Coordinate – xyz – x
2 YC Block’s Y coordinate Static Coordinate – xyz – y
3 ZC Block-s Z coordinate Static Coordinate – xyz – z
4 Period Year that the block is mined Static Mine design

Table 3: The contents of the mining cost adjustment factor file

Column # Column Name Meaning Files Type Property Type

1 XC Block’s X coordinate Static Coordinate – xyz – x
2 YC Block’s Y coordinate Static Coordinate – xyz – y
3 ZC Block-s Z coordinate Static Coordinate – xyz – z
4 MCAF Mining cost adjustment Static Important

3 Risk Analysis Parameters Definition

A mining sequence describes the life of the operation, the mines (ore bodies) involved and the processes that

material can be sent to. The current version does not support stockpiles and blending operations. The mined

material is sent to the destination that generates the highest possible value, or yields the lowest negative

value if the block does not contain any profitable elements. In addition, RAT assumes that all the blocks of

the mine schedule are mined. Prior to generating risk profiles, the variables to analyze must be defined. Risk

could be associated with:

• Tonnage sent to Mill1, Mill2, Bio-leach, Oxides and/or to waste dump.

• Metal produced from Mill1, Mill2, Bio-leach or Acid-leach.

• Discounted Cash Flow produced by material sent to Mill1, Mill2, Bio-leach, or Acid-leach.

• Cumulative Net Present Value (NPV) of the production schedule.

The user is free to create other risk profiles according to their interests.

3.1 EXERCISE 2: Martian mine risk analysis parameters definition

The workshop will focus on Tonnage and Discounted Cash Flow produced by each destination of Martian

mine during the setting of the risk analysis model. The RAT model is a set of parameters that the software

needs to generate risk analysis profiles of a mine production scheduling. To set up the parameters the user

must click the Configure button in the main window. A user interface window is opened; see Figure 4,

where the File menu permits the creation of a new set of parameters from scratch or opening the predefined

parameters.
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parameter file by selecting FileOpen and saving the parameter file when the 

configuration is done, see Figure 5. The detail of the model configuration will be 

discussed in further sections. 
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Alternatively, the user can load the predefined parameter XML file by clicking the Browse button. The

User Interface also permits verifying and modifying the predefined parameter file by selecting File→Open

and saving the parameter file when the configuration is done, see Figure 5. The detail of the model configu-

ration will be discussed in further sections.

3.2 Setting up the mine’s life operation

The life of the operation refers to the periods in which the mines operate. A simple case is for a single mine,

where the operation life is defined by the life of the single mine. More complex cases can consider multiple

mines, where each mine can operate at different times and may have temporary shut-downs. The user will

be asked to enter the mining operation periods to be considered: time period or phases. A risk analysis of

pushbacks for multiple mines is not recommended when pushbacks are mined over different time periods (as

is commonly the case).

Figure 6 shows the mining periods window displayed when creating a new risk analysis configuration. In

this window, the user is asked to enter the mining periods for the life of the operation. By default, Range of

periods radio button is checked and permits the user to enter a range of periods.
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the operation. By default, range of period ratio button is checked and permits the user to 
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To input a range of periods, the user could enter the lowest period number in the From 

textbox and the final period in the To textbox, e.g., the life of Martian mine needs to be 

set from 3 period to 10 period. To insert the periods press Insert Period button. 

 

 

Figure 6:  Initializing the periods of Martian mining operation 

All changes should appear in the left hand list. To add periods individually, the user can 

check the Specific Period radio button, which permits the user to enter periods one at a 

time.  

 

Once the period number is entered, the user should check the insert button to insert the 

period. The operation mine’s life is saved by pressing the Ok button in the bottom right 

corner of the application. Given that this is a single-mine scenario and we do not consider 

planned shutdowns, the mine will operate for all the 7 periods. This information is taken 

from the MartianPhases.txt file. 

To input a range of periods, the user could enter the lowest period number in the From textbox and the

final period in the To textbox, e.g., the life of Martian mine needs to be set from 3 period to 10 period. To

insert the periods press Insert Periods button.

351  

 

 

 

the operation. By default, range of period ratio button is checked and permits the user to 

enter a range of periods. 

  

To input a range of periods, the user could enter the lowest period number in the From 

textbox and the final period in the To textbox, e.g., the life of Martian mine needs to be 

set from 3 period to 10 period. To insert the periods press Insert Period button. 

 

 

Figure 6:  Initializing the periods of Martian mining operation 

All changes should appear in the left hand list. To add periods individually, the user can 

check the Specific Period radio button, which permits the user to enter periods one at a 

time.  

 

Once the period number is entered, the user should check the insert button to insert the 

period. The operation mine’s life is saved by pressing the Ok button in the bottom right 

corner of the application. Given that this is a single-mine scenario and we do not consider 

planned shutdowns, the mine will operate for all the 7 periods. This information is taken 

from the MartianPhases.txt file. 



Les Cahiers du GERAD G–2013–65 7

350  

 

 

 

 

 

Figure 5: The upper box is part of the main window and the bottom panel shows the default parameter file 

Martian_Mine.xml. 
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The life of the operation refers to the periods in which the mines operate. A simple case is 
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Figure 6 shows the mining periods window displayed when creating a new risk analysis 
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Figure 5: The upper box is part of the main window and the bottom panel shows the default parameter file
Martian Mine.xml
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All changes should appear in the left hand list. To add periods individually, the user can check the

Specific Period radio button, which permits the user to enter periods one at a time.
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from the MartianPhases.txt file. 

Once the period number is entered, the user should check the Insert button to insert the period. The

operation mine’s life is saved by pressing the Ok button in the bottom right corner of the application. Given

that this is a single-mine scenario and we do not consider planned shutdowns, the mine will operate for all

the 7 periods. This information is taken from the MartianPhases.txt file.

3.3 Setting up orebody models

The risk analysis requires several distinct and independent orebodies (or mines). To set up the parameters

regarding orebody simulations and mine is required to create a new ore body model, click the New Orebody

Model button at the top of the screen.
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about the mine. The mine's name is entered in the Mine Name text box. In addition, the 

user must provide to RAT the coordinate system information as follows:  

Alternatively, the user could select Tools→Add orebody model.

There are six steps to set up an ore body model for the risk analysis utility:

• Basic information. The user enters basic information about the ore body model, including mine

name, coordinates, block dimensions and number of blocks.

• Files. The user defines information type of the input files, their type (static or simulated) and the

relevant properties contained in the file.

• Materials. The user enters information related to the material types in the mine, their material ID

(code) and the mining cost for the material.

• Metals. The user defines elements of interest in the mine that have an impact on the economic viability

of a block. The user could create properties for each metal, for example the price ($/lb) and a conversion

factor to convert from ($/lb) to ($/t).

• Expressions editor. The user can make user-defined properties out of existing properties by creating

expressions.

• Constraints. The user can use constraints to track relevant information (value, tonnages, metal) in

the risk analysis, either for groups of materials or the mine as a whole.

3.3.1 Coordinates and basic model information

The basic information window, see Figure 7, allows the user to enter general information about the mine.

The mine’s name is entered in the Mine Name text box. In addition, the user must provide to RAT the

coordinate system information as follows:

• The minimum x, y and z coordinates for the model, measured from the centre of a block with the lowest

x, y and z coordinates.

• The block sizes in the x, y and z directions. The units are not important as long as they are consistent

for each direction (i.e. meters in all directions or feet in all directions).

• The number of blocks in the x, y and z directions. This helps to define the size of the orebody model

in each direction.

Table 4 gives the basic information of the input orebody model, the coordinates, the number of blocks,

and dimensions of the blocks.

For Martian mine risk analysis model the dimensions are in meters; please remember to keep consistent

units of measurements and apply the proper conversions when necessary. The Life of Mine list on the
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Table 4: Basic information of Martian orebody model

X Y Z

Minimum 2155 2455 1505
Dimension of Block 10 10 10
Number of Blocks 122 114 57

right of the Basic information window is set by default to be the entire life of the operation. The user could

customize this list if there are planned shutdowns, or in a multi-mine scenario where one mine finishes before

another. To de-select a period, the user can click on the period that should be removed. If the Life of Mine

list is cleared (everything is deselected), the user may press the CTRL or SHIFT button on their keyboard

to select multiple periods. Alternatively, the user can click and drag while holding the button to select or

deselect multiple periods.

Enter the name of the ore body as the “Martian Mine” and provide the minimum coordinates of the

model, the block dimensions and the number of blocks according to the information of Table 4, see Figure 7.
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Figure 7: Setting up basic information for Martian mine. 

When finished entering the basic model information, press the Next button to continue to 

add data files and define model properties. 

 

3.3.2 Data sets and files  

The input data files contain information for each block, and can be classified as either 

static or simulated. These input files are loaded as a data set. A data set is an individual 

file or group of files that contain information for each block in the model. For a simulated 

data set, each input file must have the same header or column structure; however, the 

order of rows or blocks could be different amongst files.  

To start creating data sets, press the plus button below the left-hand tree.  

 

The right-hand panel will be activated to permit upload information. The Martian mine 

require three datafiles to input the geological simulations files, the design mine file and 

the Mining Cost Adjustment Factor (MCAF) file. These are shown next. 

DataFile of geological simulations 

Each input file of the simulated data represents a different grade scenario 

Figure 7: Setting up basic information for Martian mine

When finished entering the basic model information, press the Next button to continue to add data files

and define model properties.
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When finished entering the basic model information, press the Next button to continue to 

add data files and define model properties. 

 

3.3.2 Data sets and files  

The input data files contain information for each block, and can be classified as either 

static or simulated. These input files are loaded as a data set. A data set is an individual 

file or group of files that contain information for each block in the model. For a simulated 

data set, each input file must have the same header or column structure; however, the 

order of rows or blocks could be different amongst files.  

To start creating data sets, press the plus button below the left-hand tree.  

 

The right-hand panel will be activated to permit upload information. The Martian mine 

require three datafiles to input the geological simulations files, the design mine file and 

the Mining Cost Adjustment Factor (MCAF) file. These are shown next. 

DataFile of geological simulations 

Each input file of the simulated data represents a different grade scenario 

3.3.2 Data sets and files

The input data files contain information for each block, and can be classified as either static or simulated.

These input files are loaded as a data set. A data set is an individual file or group of files that contain

information for each block in the model. For a simulated data set, each input file must have the same header

or column structure; however, the order of rows or blocks could be different amongst files.

To start creating data sets, press the plus (+) button below the left-hand tree.
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Figure 7: Setting up basic information for Martian mine. 

When finished entering the basic model information, press the Next button to continue to 

add data files and define model properties. 

 

3.3.2 Data sets and files  

The input data files contain information for each block, and can be classified as either 

static or simulated. These input files are loaded as a data set. A data set is an individual 

file or group of files that contain information for each block in the model. For a simulated 

data set, each input file must have the same header or column structure; however, the 

order of rows or blocks could be different amongst files.  

To start creating data sets, press the plus button below the left-hand tree.  

 

The right-hand panel will be activated to permit upload information. The Martian mine 

require three datafiles to input the geological simulations files, the design mine file and 

the Mining Cost Adjustment Factor (MCAF) file. These are shown next. 

DataFile of geological simulations 

Each input file of the simulated data represents a different grade scenario 

The right-hand panel will be activated to permit upload information. The Martian mine require three

datafiles to input the geological simulations files, the design mine file and the Mining Cost Adjustment Factor

(MCAF) file. These are shown next.
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DataFile of Geological Simulations

Each input file of the simulated data represents a different grade scenario

1. Select the Type of the file. There are only two options: Simulated and Static. The set of simulations

of Martian mine are typified as Simulated, see Figure 8.

2. Select the Property tab to declare relevant information or properties for each block. Press the plus (+)

button to add a new property. The user may specify three types of properties using the information of

Table 5. After entering the properties, the user must press the Add button to save the changes.

• Coordinates: The user must specify the format, the direction and column.

• Material: Enter the name for the material and the material column.

• Important: The Martian mine require additional relevant properties that describe the block (e.g.

Tonnage, Totcu, Recovery Mill1, Recovery Mill2, Recovery BL and Recovery OL) and must specify

the property column in the simulation input files. Also, the user must specify a conversion factor,

i.e., the metal grade as a %, require a decimal value 0.01 to use the grade in further calculations.
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Figure 8: The properties set of simulation files. 

3. Select the files tab and press Datafile/Files, see Figure 9, to add files. Press the 

plus button to open the file browser. Navigate the Data subfolder of the 

installation folder to select the input data. If the data type is simulated, the user 

can select multiple files at once by pressing and holding CTRL or SHIFT on the 

keyboard while selecting the files with the mouse.  

 

Figure 9: Loading the five grade scenarios of Martian mine. 

Please verify in the left list of the previous window if the simulation files were added 

correctly. 

Figure 8: The properties set of simulation files

Table 5: Input parameters for loading geological simulations

Coordinates
Direction Format Column in File
x xyz 1
y xyz 2
z xyz 3

Material
Name Conversion Column in File
Material 1 4

Important
Name Conversion Column in File
Tonnage 1 5
CUGrade 0.01 6
Recovery Mill1 0.01 7
Recovery Mill2 0.01 8
Recovery BL 0.01 9
Recovery OL 0.01 10
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The DataFile of Martian mine simulation was set as in Figure 8.

3. Select the Files tab and press Datafile/Files, see Figure 9, to add files. Press the plus (+) button

to open the file browser. Navigate the Data subfolder of the installation folder to select the input data.

If the data type is simulated, the user can select multiple files at once by pressing and holding CTRL or

SHIFT on the keyboard while selecting the files with the mouse.
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Figure 8: The properties set of simulation files. 

3. Select the files tab and press Datafile/Files, see Figure 9, to add files. Press the 

plus button to open the file browser. Navigate the Data subfolder of the 

installation folder to select the input data. If the data type is simulated, the user 

can select multiple files at once by pressing and holding CTRL or SHIFT on the 

keyboard while selecting the files with the mouse.  

 

Figure 9: Loading the five grade scenarios of Martian mine. 

Please verify in the left list of the previous window if the simulation files were added 

correctly. 

Figure 9: Loading the five grade scenarios of Martian mine

Please verify in the left list of the previous window if the simulation files were added correctly.

DataFile of Production Schedule

The second required input data file is the production schedule periods. This file must have a period

column which is defined as Mine Design property in RAT.

1. Select the Type of the file. The production schedule file corresponds to a static data.

2. Select the Property tab to declare relevant information or properties for each block. Press the plus (+)

button to add a new property. The user may set the mine design property using the information of

Table 6.

Table 6: Input parameters for loading the mine production schedule

Coordinates
Direction Format Column in File
x xyz 1
y xyz 2
z xyz 3

Mine Design
Name Conversion Column in File
Period 1 4

The mine design property will contain the mining periods. The user can export more than one mine

design and select the one that will be used for the risk analysis. To select the mine design to evaluate, the

user should check the box and save the property.
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The second required input data file is the production schedule periods. This file must 

have a period column which is defined as Mine Design property in RAT.  

1. Select the Type of the file. The production schedule file corresponds to a static 

data.  

2. Select the property tab to declare relevant information or properties for each 

block. Press the plus button to add a new property. The user may set the mine 

design property using the information of Table 6. 

Table 6: Input parameters for loading the mine production schedule. 

 

The mine design property will contain the mining periods. The user can export 

more than one mine design and select the one that will be used for the risk 

analysis. To select the mine design to evaluate, the user should check the box and 

save the property.  

 

The DataFile of the production schedule of Martian mine should be set as in 

Figure 10. 

Direction Format Column in File

x xyz 1

y xyz 2

z xyz 3

Name Conversion Column in File

Period 1 4

Coordinates

Mine Design
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The DataFile of the production schedule of Martian mine should be set as in Figure 10.
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Figure 10: Set coordinates and mine design properties. 

3. Select the file tab and press Datafile/Files, see Figure 11, to add files. Press the 

plus button to open the file browser. Navigate the Data subfolder of the 

installation folder to select the single MartianPhases.txt input data.  

 

Figure 11: Adding mine design data file to the model. 

Note: If the static data (mining periods, MCAF) is distributed over multiple files. The 

user must create multiple data sets to read from the different files. Please verify in the left 

list of the previous window if the schedule file was added correctly. 

 

Figure 10: Set coordinates and mine design properties

3. Select the File tab and press Datafile/Files, see Figure 11, to add files. Press the plus (+) button

to open the file browser. Navigate the Data subfolder of the installation folder to select the single

MartianPhases.txt input data.
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3. Select the file tab and press Datafile/Files, see Figure 11, to add files. Press the 

plus button to open the file browser. Navigate the Data subfolder of the 

installation folder to select the single MartianPhases.txt input data.  

 

Figure 11: Adding mine design data file to the model. 

Note: If the static data (mining periods, MCAF) is distributed over multiple files. The 

user must create multiple data sets to read from the different files. Please verify in the left 

list of the previous window if the schedule file was added correctly. 

 

Figure 11: Adding mine design data file to the model

Note: If the static data (mining periods, MCAF) is distributed over multiple files. The user must create

multiple data sets to read from the different files. Please verify in the left list of the previous window if the

schedule file was added correctly.
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DataFile of Mining Cost Adjustment Factor

The mining cost adjustment factor (MCAF) of Martian mine is given in file MartianMCAF.txt. The

MCAF of each block are constant values among the five scenarios of the grade. The DataFile for MCAF is

loaded as follow:

1. Select the Type of the file. The MCAF file corresponds to a static data.

2. Select the Property tab to declare relevant information or properties for each block, see Figure 12.

Press the plus (+) button to add four new properties. The user may set the properties of the MCAF

file using the information in Table 7.

Table 7: Input parameters for loading the mining cost adjustment factor

Coordinates
Direction Format Column in File
x xyz 1
y xyz 2
z xyz 3

Important
Name Conversion Column in File
MCAF 1 4

The DataFile of the Martian mine MCAF static data should be set as in Figure 12.
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DataFile of Mining Cost Adjustment Factor  

The mining cost adjustment factor (MCAF) of Martian mine is given in file 

MartianMCAF.txt. The MCAF of each block are constant values among the five 

scenarios of the grade. The DataFile for MCAF is loaded as follow: 

1. Select the Type of the file. The MCAF file corresponds to a static data.  

2. Select the property tab to declare relevant information or properties for each 

block, see Figure 12. Press the plus button to add four new properties. The user 

may set the properties of the MCAF file using the information in Table 7. 

Table 7: Input parameters for loading the mining cost adjustment factor. 

 

The DataFile of the Martian mine MCAF static data should be set as in Figure 12. 

 

Figure 12: Set coordinates and important property (MCAF). 

 

Direction Format Column in File

x xyz 1

y xyz 2

z xyz 3

Name Conversion Column in File

MCAF 1 4

Coordinates

Important

Figure 12: Set coordinates and important property (MCAF)

3. Select the File tab and press Datafile/Files, see Figure 13, to add files. Press the plus (+) button

to open the file browser. Navigate the subfolder Data of the installation folder to select the single

MartianMCAF.txt input file.

The MCAF factors are constant values read from important property that will be applied to each simu-

lation After entering all relevant information for the data sets, press the Next button to continue to define

the Martian mine’s material types.
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3. Select the file tab and press Datafile/Files, see Figure 13, to add files. Press the 

plus button to open the file browser. Navigate the subfolder Data of the 

installation folder to select the single MartianMCAF.txt input file. 

 

Figure 13: Adding MCAF data file to the model 

The MCAF factors are constant values read from important property that will be applied 

to each simulation After entering all relevant information for the data sets, press the Next 

button to continue to define the Martian mine's material types. 

3.3.3 Materials 

A mine may have material types flagged by codes. The material window permits the user 

to associate the material names with material codes and mining costs. The material codes 

are integer values stored in Material property defined in the previous DataSet section. 

Press the plus button below the left hand list to add a new material, see Figure 14. Then, 

the Add New Material box on the right-hand side is enabled. Enter the name for the 

material (e.g. "Waste" or "SULF "), the material code and the mining cost. For Martian 

mine we have five material that are part of the simulation files as Mat_Type column. The 

summary of these codes and their respective mining cost are shown in Table 8.  

 

Figure 13: Adding MCAF data file to the model

3.3.3 Materials

A mine may have material types flagged by codes. The material window permits the user to associate

the material names with material codes and mining costs. The material codes are integer values stored in

Material property defined in the previous DataSet section.

Press the plus (+) button below the left hand list to add a new material, see Figure 14. Then, the Add

New Material box on the right-hand side is enabled. Enter the name for the material (e.g. “Waste” or

“SULF”), the material code and the mining cost. For Martian mine we have five material that are part of

the simulation files as Mat Type column. The summary of these codes and their respective mining cost are

shown in Table 8.
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Table 8: Input parameters for loading material of Martian mine to model. 

 

Press the Add button to save the material information and repeat the process for each 

material type using the information in Table 8 as follows: 

 

Figure 14: Adding materials and specifying mining cost for the Martian mine risk analysis model. 

Note: If some material requires extra drilling and blasting, the user could specify different 

mining costs for each material.  

When finished, pres the Next button to continue the setting of the Martian mine’s metal 

types. 

3.3.4 Metals 

Metals are used to describe elements of interest in the blocks; the element could be a 

metal value and also some property that provides either a positive or negative economic 

value to a block. Figure 15 shows the window used to add metals to the ore body model. 

To add a metal (or element of interest), press the plus button below the left-hand tree, 

Material Name Material Code Mining Cost

Waste 1 1.5

SULF1 2 1.5

SULF2 3 1.5

MIXED 4 1.5

OXIDES 5 1.5

Figure 14: Adding materials and specifying mining cost for the Martian mine risk analysis model
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Table 8: Input parameters for loading material of Martian mine to model

Material Name Material Code Mining Cost

Waste 1 1.5
SULF1 2 1.5
SULF2 3 1.5
MIXED 4 1.5
OXIDES 5 1.5

Press the Add button to save the material information and repeat the process for each material type using

the information in Table 8 (see Figure 14).

Note: If some material requires extra drilling and blasting, the user could specify different mining costs

for each material.

When finished, press the Next button to continue the setting of the Martian mine’s metal types.

3.3.4 Metals

Metals are used to describe elements of interest in the blocks; the element could be a metal value and also

some property that provides either a positive or negative economic value to a block. Figure 15 shows the

window used to add metals to the ore body model. To add a metal (or element of interest), press the plus (+)

button below the left-hand tree, enter a metal name (e.g. “Copper”, “Au”, etc.), and press the Add button.

The properties that are relevant to include are the value of the metal (e.g. $/lb metal) or a conversion

factor to convert the metal value from $/lb to $/t. For Martian mine the metal ”Cu” must contain one

property called “Value” with the metal’s projected price 1.76 as property value and another property called

“ConvertPoundsToTonnes” with the conversion factor 2204.622 as property value.
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that are relevant to include are the value of the metal (e.g. $/lb metal) or a conversion 

factor to convert the metal value from $/lb to $/t. For Martian mine the metal "Cu" must 

contain one property called "Value" with the metal's projected price 1.76 as property 
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2204.622  as property value. 

 

Figure 15: Adding metal and metal properties to the Martian mine risk analysis model. 

After all metals or elements have been declared, press next to continue the setting of the 

Orebody Model parameters. 

3.3.5 Expression  

Expressions are processed by the software and treated as new properties, similar to the 

data file properties seen earlier. The expression editor is used for two primary purposes:  

 To tell the software how to calculate the value of a block and permit a high-

degree of complexity evaluations. 

 To create new properties based on data file properties that were loaded. This 

avoids pre-processing steps.  

To create an expression, press the plus button on the bottom of the left-hand list. Give the 

expression a name, and specify whether or not the expression defines a block value or a 

Figure 15: Adding metal and metal properties to the Martian mine risk analysis model

After all metals or elements have been declared, press Next to continue the setting of the Orebody Model

parameters.

3.3.5 Expression

Expressions are processed by the software and treated as new properties, similar to the data file properties

seen earlier. The expression editor is used for two primary purposes:



16 G–2013–65 Les Cahiers du GERAD

• To tell the software how to calculate the value of a block and permit a high-degree of complexity

evaluations.

• To create new properties based on data file properties that were loaded. This avoids pre-processing

steps.

To create an expression, press the plus (+) button on the bottom of the left-hand list. Give the expression

a name, and specify whether or not the expression defines a block value or a property. The Martian mine

require the creation of Metal Content expression and Value expression. To calculate the tonnage of metal in

a block for a copper mine, the expression of metal content is set as in Table 9.

Table 9: Expression required to do the risk analysis evaluation of Martian mine

Name Save As Expression

MetalContent Property Block.CuGrade * Block.Tonnage

Block.MetalContent * Process.Recovery.Cu * (BlockModel.Metal.Cu.Value *

Value Block Value BlockModel.metal.Cu.ConvertPoundsToTonnes) – BlockModel.MiningCost * Block.MCAF *

Block.Tonnage – Process.ProcessingCost * Block.Tonnage

The value by block is calculated by the revenue of the block minus the mining and processing costs

of the block. The two expression of Martian mine are set as in Figure 16; however, it is important to

remark that the second expression in the previous table is calculated after the Process is set because the

Process.ProcessingCost variable is defined in the Process section that follows.

All the defined properties of former sections appear as variables and are available to create expressions.

The created expressions automatically are registered as additional variables (e.g., The Block.MetalContent

variable, see Figure 16, corresponds to the first expression created for Martian mine). The Metal Content

expression is used to create an expression to define the value of each block, that is, expressions are used in

consecutive expressions as one variable more, see Figure 16.
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Figure 16: Adding expression to the Martian mine risk analysis model. 

Under the Expression panel, each variable is defined by one of three major categories 

and their respective sub-properties. The BlockModel category and Block category are 

explained in this section and the Process category will be explained in the Process 

section.  

 OrebodyModel. Parameters that apply to the whole orebody model. 

 MiningCost - mining cost for the block because the software considers 

that these costs may change depending on what material the block is 

classified as, e.g., OrebodyModel.MiningCost. 

 Metal - the software search for the metals added and each respective sub-

properties (OrebodyModel.Metal. (Metal Name).(Metal Property)), e.g., 

OrebodyModel.Metal.Cu.Value. 

 Block. Properties can change from block-to-block and between each simulation. 

 (Property name) - the properties loaded from the data files, e.g., 

Block.CuGrade. 

 (Expression name) - a new expression can be evaluated from previously 

defined expressions. As you add more expressions to the model, these 

expressions will be added to the variable list, e.g., Block.MetalContent. 

Figure 16: Adding expression to the Martian mine risk analysis model

Under the Expression panel, each variable is defined by one of three major categories and their respective

sub-properties. The BlockModel category and Block category are explained in this section and the Process

category will be explained in the Process section.
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• OrebodyModel. Parameters that apply to the whole orebody model.

MiningCost – mining cost for the block because the software considers that these costs may change

depending on what material the block is classified as, e.g., OrebodyModel.MiningCost.

Metal – the software search for the metals added and each respective sub-properties (Orebody-

Model.Metal. (Metal Name).(Metal Property)), e.g., OrebodyModel.Metal.Cu.Value.

• Block. Properties can change from block-to-block and between each simulation.

(Property name) – the properties loaded from the data files, e.g., Block.CuGrade.

(Expression name) – a new expression can be evaluated from previously defined expressions. As

you add more expressions to the model, these expressions will be added to the variable list, e.g.,

Block.MetalContent.

Note: The expression editor panel is displayed only in this Orebody Model section and some expressions

may require variables from the next Process section, that is, the user must return to this Orebody Model

section to finish the setting of expressions that use Process variables when the next Process section has been

set.

To save the expression to the model, press the Add button. After the expressions have been entered, press

the Next button to continue with the setting of constraints.

3.3.6 Constraints

The constraints are used to track relevant information. Constraints can be used to track the tonnage mined

from the orebody over the entire life of a mine, over only specific periods and over specific materials. The

constraint can be customized for specific properties, periods and materials. The Martian mine constrains are

set as in Figure 17.
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Note: The expression editor panel is displayed only in this Orebody Model section and 

some expressions may require variables from the next Process section, that is, the user 

must return to this Orebody Model section to finish the setting of expressions that use 

Process variables when the next Process section has been set.  

To save the expression to the model, press the Add button. After the expressions have 

been entered, press the Next button to continue with the setting of constraints. 

3.3.6 Constraints 

The constraints are used to track relevant information. Constraints can be used to track 

the tonnage mined from the orebody over the entire life of a mine, over only specific 

periods and over specific materials. The constraint can be customized for specific 

properties, periods and materials. The Martian mine constrains are set as in Figure 17. 

 

Figure 17: Adding constraints to define which variables RAT should use to calculate a risk profile. 

Press the plus button found in the lower left of the Constraints window to create 

conditions, see Figure 17. Enter a description of the constraint (e.g., "Tonnage"). Select 

the Block.Tonnage property from the drop-down combo box; all block properties and 

expressions are listed in this box, that is, the user can select which periods to track the 

property in or which property to track by selecting the period(s) or/and material(s) from 

the appropriate lists. After all metals or elements have been declared, press the Next 

Figure 17: Adding constraints to define which variables RAT should use to calculate a risk profile

Press the plus (+) button found in the lower left of the Constraints window to create conditions, see

Figure 17. Enter a description of the constraint (e.g., “Tonnage”). Select the Block.Tonnage property from

the drop-down combo box; all block properties and expressions are listed in this box, that is, the user can

select which periods to track the property in or which property to track by selecting the period(s) or/and

material(s) from the appropriate lists. After all metals or elements have been declared, press the Next button

to continue the setting of the risk analysis model. Also, the user should save the progress of the parameter
configuration by clicking Save in the File menu.
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3.4 Setting up processes

Processes are destinations that extracted material can be sent to. RAT assumes that the specify process is

the final destination for the material and the saleable product is evaluated unless the destination is waste,

where recovery is 0.0. Five consecutive steps define each process and are as follows:

• Basic information: name of the process.

• Processing costs: defines which incoming materials the process accepts. Costs can be changed depending

on the material being processed.

• Recovery: different recoveries can be applied to the various metals and materials from each of the

simulations and mines.

• Properties: information that applies to each process; values can vary depending on the process (e.g.

refining charges).

• Constraints: methods to track the relevant information on material sent to the process over time.

The number of processes required will depend on the mine. To create a process, press the New Process

button or select Tools→Add Process.
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button to continue the setting of the risk analysis model. Also, the user should save the 

progress of the parameter configuration by clicking Save in the File menu.  

3.4 Setting up processes 

Processes are destinations that extracted material can be sent to. RAT assumes that the 

specify process is the final destination for the material and the saleable product is 

evaluated unless the destination is waste, where recovery is 0.0. Five consecutive steps 

define each process and are as follows:  

 Basic information: name of the process. 

 Processing costs: defines which incoming materials the process accepts. Costs can 

be changed depending on the material being processed. 

 Recovery: different recoveries can be applied to the various metals and materials 

from each of the simulations and mines. 

 Properties: information that applies to each process; values can vary depending on 

the process (e.g. refining charges). 

 Constraints: methods to track the relevant information on material sent to the 

process over time. 

The number of processes required will depend on the mine. To create a process, press the 

New Process button or select Tools  Add Process.  

 

Each process is set following the previous five steps. The Martian mine require to add 

waste process, Mill1 process, Mill2 process, Bioleach process and Oxide process to the 

risk analysis model, that is, these processes are added  and set one after the other. 

3.4.1 Basic information 

Unlike the ore body model, the basic information for a process should be fairly 

straightforward and only the name of the process is required, see Figure 18.  

Each process is set following the previous five steps. The Martian mine require to add waste process,

Mill1 process, Mill2 process, Bio-leach process and Oxide process to the risk analysis model, that is, these

processes are added and set one after the other.

3.4.1 Basic information

Unlike the ore body model, the basic information for a process should be fairly straightforward and only the

name of the process is required, see Figure 18.
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Figure 18: Setting up the basic information for waste process.  

Enter the name in the Process Name textbox. When finished, press the Save button. 

3.4.2 Processing costs 

Processing costs are used to charge a monetary value to the incoming material from the 

mine and the user must define which materials can be sent to the process being created. 

All materials from the orebodies are loaded in the left-hand list. The Martian mine 

presents five materials that should be linked with each process, see Table 10. 

Table 10: The material of each Martian mine process and the associated processing cost. 

 

By defining a processing cost for a material in the left-hand pane, the user decides if the 

process accepts that incoming material type. When there is no cost associated, the user 

can select all materials with default cost of $0. (e.g., waste dump without associated 

treatment charges). The Process Cost window should be set using the information in 

Table 10 for each process of Martian mine. 

 

Figure 19: Setting up the processing cost for Martian mine input materials. 

When a material is selected and a processing cost is entered, the information can be saved 

by pressing the ok button on the right-hand side of the screen. Any materials that are not 

Material

Name Waste
Processing 

Cost Mill1
Processing 

Cost Mill2
Processing 

Cost
Bio-

leach

Processing 

Cost
Oxide 

Leach

Processing 

Cost

Waste Selected 0

SULF1 Selected 0 Selected 6 Selected 6 Selected 1.5

SULF2 Selected 0 Selected 6 Selected 6 Selected 1.5

MIXED Selected 0 Selected 1.5

OXIDES Selected 0 Selected 4

 

Figure 18: Setting up the basic information for waste process

Enter the name in the Process Name textbox. When finished, press the Save button.

3.4.2 Processing costs

Processing costs are used to charge a monetary value to the incoming material from the mine and the user

must define which materials can be sent to the process being created. All materials from the orebodies are

loaded in the left-hand list. The Martian mine presents five materials that should be linked with each process,

see Table 10.

By defining a processing cost for a material in the left-hand pane, the user decides if the process accepts

that incoming material type. When there is no cost associated, the user can select all materials with default

cost of $0. (e.g., waste dump without associated treatment charges). The Process Cost window should be

set using the information in Table 10 for each process of Martian mine.

When a material is selected and a processing cost is entered, the information can be saved by pressing

the Ok button on the right-hand side of the screen. Any materials that are not saved with a cost will not

be evaluated. For Martian mine, it was assumed that all materials will have the same processing cost for a

given destination.
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Table 10: The material of each Martian mine process and the associated processing cost

Material Processing Processing Processing Bio- Processing Oxide Processing

Name Waste Cost Mill1 Cost Mill2 Cost leach Cost Leach Cost

Waste Selected 0

SULF1 Selected 0 Selected 6 Selected 6 Selected 1.5

SULF2 Selected 0 Selected 6 Selected 6 Selected 1.5

MIXED Selected 0 Selected 1.5

OXIDES Selected 0 Selected 4
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treatment charges). The Process Cost window should be set using the information in 

Table 10 for each process of Martian mine. 
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When a material is selected and a processing cost is entered, the information can be saved 

by pressing the ok button on the right-hand side of the screen. Any materials that are not 
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Cost Mill1
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Waste Selected 0
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MIXED Selected 0 Selected 1.5
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Figure 19: Setting up the processing cost for Martian mine input materials

3.4.3 Recovery

Recoveries define how effective the process is at extracting the metals (elements) of interest from the incoming

material. Recoveries can either be stored in a file or not. The user must select which ore body model and

metal the process recovers, and the associated input property that relates to the recovery for that metal.

Since RAT considers only which materials are permitted to be sent to the given process, all recoveries for

material without cost are ignored. Once the recovery form is filled out then press the Add button to save the

recovery. Be sure to repeat the process for each ore body and each metal that the process treats.

Rather than storing recoveries in input files, there is also the option to apply a “blanket” recovery for a

given metal and material. This is the case for a waste dump where it is not necessary to store the block’s

recovery. Select No from the drop-down list and enter 0 because no metal is recovered from waste.
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Rather than storing recoveries in input files, there is also the option to apply a "blanket" 

recovery for a given metal and material. This is the case for a waste dump where it is not 

necessary to store the block's recovery. Select No from the drop-down list and enter 0 

because no metal is recovered from waste. 

 

The user can specify a blank recovery value by entering it as a blanket value (Note: this is 

assumed to be a decimal value and not in percentage, %, format). The user can then select 

which mine, metal and materials the blanket factor applies to. The user should be 

cautious and ensure that a recovery is given for each mine, metal and material type. This 

can be verified by looking at the left-hand panel in Figure 20. 

The user can specify a blank recovery value by entering it as a blanket value (Note: this is assumed to be

a decimal value and not in percentage, %, format). The user can then select which mine, metal and materials

the blanket factor applies to. The user should be cautious and ensure that a recovery is given for each mine,

metal and material type. This can be verified by looking at the left-hand panel in Figure 20.

The recovery for Mill1, Mill2, Bio-leach and Oxides process are set with a unique Orebody Model Martian

Mine and a Metal Cu; otherwise happen with the set of the recovery property.

The recovery property changes for each process. The Mill1 process is linked with Recovery Mill1

property, the Mill2 process is linked with Recovery Mill2 property, the Bio-leach process is linked with

Recovery BL property and the Oxide process is linked with Recovery OL property, see Figure 21.

The defining recoveries for metals are stored as a model property and when all recoveries have been

entered for the process, press the Next button to continue on to define process properties.

3.4.4 Properties

Properties can be defined for each process and can differ for each of the processes (destinations). As long
as the property name remains the same from process to process, RAT will apply the correct property value

when evaluating ore body model expressions. For example, a refining charge may apply to milled material,
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Figure 20: Add recovery for each material in Waste process. 

The recovery for Mill1, Mill2, Bioleach and Oxides process are set with a unique 

Orebody Model Martian Mine and a Metal Cu; otherwise happen with the set of the 

recovery property. 

The recovery property changes for each process. The Mill1 process is linked with 

Recovery Mill1 property, the Mill2 process is linked with Recovery Mill2 property, the 

Bioleach process is linked with Recovery BL property and the Oxide process is linked 

with Recovery OL property, see Figure 21. 

 

Figure 20: Add recovery for each material in Waste process
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Figure 21: Set recovery for a metal Cu whether recovery is read from simulations files. 

The defining recoveries for metals are stored as a model property and when all recoveries 

have been entered for the process, press the Next button to continue on to define process 

properties. 

3.4.4 Properties 

Properties can be defined for each process and can differ for each of the processes 

(destinations). As long as the property name remains the same from process to process, 

RAT will apply the correct property value when evaluating ore body model expressions. 

For example, a refining charge may apply to milled material, which is different than a 

refining charge applied to materials from an oxide leach. To accommodate this, a 

"charge" property can be created for each of the processes, and different values are 

supplied for the mills and the leached material. The property can then be included in the 

ore body model expression for calculating block values; if a property is not specified for 

the process (e.g. a "charge" property for the waste), the default value will be 0 and no 

charge will be applied at all.  

Figure 21: Set recovery for a metal Cu whether recovery is read from simulations files

which is different than a refining charge applied to materials from an oxide leach. To accommodate this, a

“charge” property can be created for each of the processes, and different values are supplied for the mills and

the leached material. The property can then be included in the ore body model expression for calculating

block values; if a property is not specified for the process (e.g. a “charge” property for the waste), the default

value will be 0 and no charge will be applied at all.

This feature may not be necessary in many cases; however, it is available to provide some flexibility when

modeling the user-defined properties and block values for the ore body models. To add a property to the

process, press the plus (+) button below the left-hand list. When the name and value have been entered,
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Figure 22: Creating process properties. 

This feature may not be necessary in many cases; however, it is available to provide some 

flexibility when modeling the user-defined properties and block values for the ore body 

models. To add a property to the process, press the plus button below the left-hand list. 

When the name and value have been entered, press the Add button to save the changes. 

The Martian Mine did not require the use of property by process. Then, we can leave 

empty this window for all the process and press the Next button to continue to enter the 

process constraints. 

3.4.5 Constraints 

Similar to ore body model constraints, the process constraints are used to track relevant 

incoming material over the life of the mine, which ultimately are used to generate risk 

profiles. Note that this form is slightly different from the mine constraint form; however, 

the operation is quite similar.  

To add a constraint, press the plus button below the left-hand list and provide a 

description of the constraint, for example Mill 1 Tonnage. The Apply to Properties box 

will list all properties and user-defined expressions for all of the ore bodies. If the user 

wishes to track incoming tonnages from multiple mines, press and hold CTRL or SHIFT 

while selecting items from the list. The software will add the values for each production 

Figure 22: Creating process properties

press the Add button to save the changes. The Martian Mine did not require the use of property by process.

Then, we can leave empty this window for all the process and press the Next button to continue to enter the

process constraints.

3.4.5 Constraints

Similar to ore body model constraints, the process constraints are used to track relevant incoming material

over the life of the mine, which ultimately are used to generate risk profiles. Note that this form is slightly

different from the mine constraint form; however, the operation is quite similar.

To add a constraint, press the plus (+) button below the left-hand list and provide a description of the

constraint, for example Mill1 Tonnage. The Apply to Properties box will list all properties and user-

defined expressions for all of the ore bodies. If the user wishes to track incoming tonnages from multiple

mines, press and hold CTRL or SHIFT while selecting items from the list. The software will add the values for

each production period (e.g. tonnages or value from two mines). Select the production periods that should

be tracked, along with the material types that should be tracked. If only certain incoming materials should

be tracked, select the relevant materials by holding CTRL or SHIFT.

The software has a specific method for parsing user-defined expressions; each variable is defined by

one of three major categories and their respective sub-properties. The Process category is related to the

destinations that material can be sent to (including a waste dump).

• ProcessingCost – processing costs are similar to mining costs in the essence that they can be customized

or changed depending on the material type. The software will automatically apply the correct cost to

the block depending on which material is selected.

• Recovery.(Metal name) – a given destination may attain various recoveries for different metals, which

can differ from one process to the next.

• (Property name) – a process property can be applied for each process and used in the software. An

example of this is a deduction per pound of metal; the deduction may be lower when the final metal

product comes from a smelter rather than, for example, an oxide leach pad. If the same property name

is applied for each process, the software will apply the appropriate deduction when calculating the value

for the block.
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For Martian mine we need to create Value constraints and Tonnage constraints that will be linked to

MartianMine.Value and MartianMine.Tonnage property respectively and select all the period and material.

These processing constraints are set as in Figure 23.
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Figure 23: Creating constrains to track information about incoming material to a process. 

The process constraints are created in the same way for all the processes. 

3.5 Defining risk analysis outputs 

At the final step, the user defines the risk analysis output where is evaluated the 

performance of a mine design given several scenarios of the grade. To create a new risk 

analysis output, press the New Risk analysis button, or alternatively select ToolsRisk 

Analysis from menu.  

 

The constraint drop-down menu will allow the user to select any of the ore body model or 

process constraints previously defined. The output data of the risk analysis will be saved 

to the Output File - for example, the user could enter "mill1_value.txt" as an output file 

name.  

A discount rate can be entered to gradually decrease the impact of values in the future. 

This is particularly useful for Net Present Value (NPV) analyses where a discount rate is 

typically used. A discount rate of 0 will yield no discounting at all. The values should lie 

between 0 and 1. To plot a cumulative distribution, check the cumulative checkbox.  

 

Figure 23: Creating constraints to track information about incoming material to a process

The process constraints are created in the same way for all the processes.

3.5 Defining risk analysis outputs

At the final step, the user defines the risk analysis output where is evaluated the performance of a mine design

given several scenarios of the grade. To create a new risk analysis output, press the New Risk analysis

button, or alternatively select Tools→Risk Analysis from menu.
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Figure 23: Creating constrains to track information about incoming material to a process. 

The process constraints are created in the same way for all the processes. 

3.5 Defining risk analysis outputs 

At the final step, the user defines the risk analysis output where is evaluated the 

performance of a mine design given several scenarios of the grade. To create a new risk 

analysis output, press the New Risk analysis button, or alternatively select ToolsRisk 

Analysis from menu.  

 

The constraint drop-down menu will allow the user to select any of the ore body model or 

process constraints previously defined. The output data of the risk analysis will be saved 

to the Output File - for example, the user could enter "mill1_value.txt" as an output file 

name.  

A discount rate can be entered to gradually decrease the impact of values in the future. 

This is particularly useful for Net Present Value (NPV) analyses where a discount rate is 

typically used. A discount rate of 0 will yield no discounting at all. The values should lie 

between 0 and 1. To plot a cumulative distribution, check the cumulative checkbox.  

 

The constraint drop-down menu will allow the user to select any of the ore body model or process

constraints previously defined. The output data of the risk analysis will be saved to the Output File – for

example, the user could enter “mill1 value.txt” as an output file name.

A discount rate can be entered to gradually decrease the impact of values in the future. This is particularly

useful for Net Present Value (NPV) analyses where a discount rate is typically used. A discount rate of 0

will yield no discounting at all. The values should lie between 0 and 1. To plot a cumulative distribution,

check the Cumulative checkbox.
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Figure 23: Creating constrains to track information about incoming material to a process. 

The process constraints are created in the same way for all the processes. 

3.5 Defining risk analysis outputs 

At the final step, the user defines the risk analysis output where is evaluated the 

performance of a mine design given several scenarios of the grade. To create a new risk 

analysis output, press the New Risk analysis button, or alternatively select ToolsRisk 

Analysis from menu.  

 

The constraint drop-down menu will allow the user to select any of the ore body model or 

process constraints previously defined. The output data of the risk analysis will be saved 

to the Output File - for example, the user could enter "mill1_value.txt" as an output file 

name.  

A discount rate can be entered to gradually decrease the impact of values in the future. 

This is particularly useful for Net Present Value (NPV) analyses where a discount rate is 

typically used. A discount rate of 0 will yield no discounting at all. The values should lie 

between 0 and 1. To plot a cumulative distribution, check the cumulative checkbox.  

 

If the values should be standardized in terms of the average over all simulations for each period, check

the Standardize checkbox.
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If the values should be standardized in terms of the average over all simulations for each 

period, check the standardize checkbox.  

 

When we have more than 20 simulations, the risk analysis graph can become cluttered. 

The Risk Analysis window gives the option of selecting only the minimum, maximum 

and averages for each period. The Martian mine risk analysis output files is set as in 

Figure 24.  

 

Figure 24: Preparing the risk analysis outputs. 

The changes must be saved by pressing the Save changes button after filling out the 

form.  

 

When the preparation of the risk analysis output is completed, the whole parameter must 

be saved by selecting File  Save from menu. 

4 Generating Risk Profiles 

After the parameter file has been loaded or set, the user may press Run button to perform 

the risk analysis tool.  

When we have more than 20 simulations, the risk analysis graph can become cluttered. The Risk

Analysis window gives the option of selecting only the minimum, maximum and averages for each period.

The Martian mine risk analysis output files is set as in Figure 24.
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Figure 24: Preparing the risk analysis outputs. 

The changes must be saved by pressing the Save changes button after filling out the 

form.  

 

When the preparation of the risk analysis output is completed, the whole parameter must 

be saved by selecting File  Save from menu. 

4 Generating Risk Profiles 

After the parameter file has been loaded or set, the user may press Run button to perform 

the risk analysis tool.  

Figure 24: Preparing the risk analysis outputs

The changes must be saved by pressing the Save changes button after filling out the form.
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When we have more than 20 simulations, the risk analysis graph can become cluttered. 

The Risk Analysis window gives the option of selecting only the minimum, maximum 

and averages for each period. The Martian mine risk analysis output files is set as in 
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Figure 24: Preparing the risk analysis outputs. 

The changes must be saved by pressing the Save changes button after filling out the 

form.  

 

When the preparation of the risk analysis output is completed, the whole parameter must 

be saved by selecting File  Save from menu. 

4 Generating Risk Profiles 

After the parameter file has been loaded or set, the user may press Run button to perform 

the risk analysis tool.  

When the preparation of the risk analysis output is completed, the whole parameter must be saved by

selecting File→Save from menu.

4 Generating Risk Profiles

After the parameter file has been loaded or set, the user may press Run button to perform the risk analysis
tool.
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Figure 25: Generating the risk analysis outputs. 

The progress of the evaluation is reported in the Process Status box and any errors 

encountered will be reported as well. The utility progresses through six main stages: 

 Load the ore body models into memory. 

 Initialize the process or destinations. 

 Remove unnecessary information (filtering). 

 Evaluate the mine constraints. 

 Evaluate the process constraints. 

 Save the risk analysis outputs to a set of files. 

The progress of the evaluation is reported in the Process Status box and any errors encountered will

be reported as well. The utility progresses through six main stages:

• Load the ore body models into memory.

• Initialize the process or destinations.

• Remove unnecessary information (filtering).

• Evaluate the mine constraints.

• Evaluate the process constraints.

• Save the risk analysis outputs to a set of files.

The output is a set of risk analysis files that store the period and value for the parameter of interest for

each simulation (or combination of simulations, in the case of multiple mines), see Figure 25.

The risk profiles are generated and saved in hard disk. The risk analysis graphic could be done directly

in the RA software or by using Microsoft Excel.
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Figure 25: Generating the risk analysis outputs. 

The progress of the evaluation is reported in the Process Status box and any errors 

encountered will be reported as well. The utility progresses through six main stages: 

 Load the ore body models into memory. 

 Initialize the process or destinations. 

 Remove unnecessary information (filtering). 

 Evaluate the mine constraints. 

 Evaluate the process constraints. 

 Save the risk analysis outputs to a set of files. 

Figure 25: Generating the risk analysis outputs

5 Graphs of Risk Profiles

When the risk analysis process is completed, RAT provides two alternatives to display the risk analysis

profiles: one option is to display the graphs directly from the RA software and the other is to use Microsoft

Excel. To display in the software we select the required profile from the output list and then click Show

Result, see Figure 26.
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The output is a set of risk analysis files that store the period and value for the parameter 

of interest for each simulation (or combination of simulations, in the case of multiple 

mines), see Figure 25. 

The risk profiles are generated and saved in hard disk. The risk analysis graphic could be 

done directly in the RA software or by using Microsoft Excel. 

5 Graphs of Risk Profiles 

When the risk analysis process is completed, RAT provides two alternatives to displaythe 

risk analysis profiles: one option is to display the graphs directly from the RA software 

and the other is to use Microsoft Excel. To display in the software we select the required 

profile from the output list and then click show results, see Figure 26. 

 

Figure 26: Section of risk analysis’ main window used to display risk profile graphs. 

A window with two tabs is opened: the first tab contains the profile graph and the second 

tab contains the profile data in a table, see Figure 27. 

Figure 26: Section of risk analysis’ main window used to display risk profile graphs
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A window with two tabs is opened: the first tab contains the profile graph and the second tab contains

the profile data in a table, see Figure 27.
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Figure 27: The chart and data of treated tonnages in Mill1 given 5 realizations.  

Once the graph is displayed, the profile selected disappears from the list. This option will 

work only once for each risk profile; however, the risk profiles output are stored in the 

working folder and the user could produce graphic representations again in the software 

that he/she prefers.  

To load directly the risk data in Microsoft and visualize the risk profiles, press the Show 

Results button in the main window of the risk analysis tool and make sure to check the 

Excel Version radio button, see Figure 28.  

Figure 27: The chart and data of treated tonnages in Mill1 given 5 realizations

Once the graph is displayed, the profile selected disappears from the list. This option will work only once

for each risk profile; however, the risk profiles output are stored in the working folder and the user could

produce graphic representations again in the software that he/she prefers.

To load directly the risk data in Microsoft and visualize the risk profiles, press the Show Result button

in the main window of the risk analysis tool and make sure to check the Excel Version radio button, see

Figure 28.
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Figure 28: Section of risk analysis main window used to display risk profiles in Excel. 

The software will automatically load a table and create a chart into a new Excel sheet, see 

Figure 29.  

 

Figure 29: Risk analysis profiles displayed in Excel. 

The excel chart shows a risk profile graph similar to the graph in RA software. The user 

could use Excel tools to better customize the graphs.   

5.1 EXERCISE 3: graph Martian mine risk analysis profiles 

The Martian mine presents 5 material types and 5 destinations. The tones sent to each 

destination and the values that produce this decision were evaluated. 12 risk profiles were 

generated and will be displayed in Microsoft Excel, 5 profiles are linked with tones sent 
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The software will automatically load a table and create a chart into a new Excel sheet, see Figure 29.
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Figure 28: Section of risk analysis main window used to display risk profiles in Excel. 

The software will automatically load a table and create a chart into a new Excel sheet, see 

Figure 29.  
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Figure 28: Section of risk analysis main window used to display risk profiles in Excel
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Figure 29: Risk analysis profiles displayed in Excel

The Excel chart shows a risk profile graph similar to the graph in RA software. The user could use Excel

tools to better customize the graphs.

5.1 EXERCISE 3: Graph Martian mine risk analysis profiles

The Martian mine presents 5 material types and 5 destinations. The tones sent to each destination and the

values that produce this decision were evaluated. Twelve risk profiles were generated and will be displayed

in Microsoft Excel, 5 profiles are linked with tones sent to each destination, 1 profile considers all the tones

produced, 5 profiles are linked to the value that produced the 5 destinations and 1 profile considers the total

value for the Martian mine. The risk analysis of the total production and expected value is show in Figure 30.

The production schedule plan considers 7 periods to mine the Martian copper deposit. The risk analysis

of the total production given 5 scenarios of the grade show that the first 3 periods has low risk; meanwhile,

the next 4 periods show a considerable high risk to accomplish the proposed plan. Particularly, the period

eight has a space of uncertainty from 200 million to 350 million. On the other hand, the total tonnage

remains invariable through the 7 periods because the risk analysis is performed into a static mine design. As

expected, the total tonnage mined given variable scenarios of the grade does not change.

The next risk analysis evaluates the waste extracted, see Figure 31.
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to each destination, 1 profile considers all the tones produced, 5 profiles are linked to the 

value that produced the 5 destinations and 1 profile considers the total value for the 

Martian mine. The risk analysis of the total production and expected value is show in 

Figure 30. 

 

 

Figure 30: Risk analysis of the expected Discounted Cash Flow of Martian mine and total tonnage mined. 

The production schedule plan considers 7 periods to mine the Martian copper deposit. 

The risk analysis of the total production given 5 scenarios of the grade show that the first 

3 periods has low risk;  meanwhile, the next 4 periods show a considerable high risk to 

accomplish the proposed plan. Particularly, the period eight has a space of uncertainty 

from 200 million to 350 million. On the other hand, the total tonnage remains invariable 
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Figure 30: Risk analysis of the expected Discounted Cash Flow of Martian mine and total tonnage mined

The tonnage of the waste fluctuates given 5 geological simulations because the material type changes

among the different scenarios of the grade. A considerable risk is associated with the periods from 8 to 10

for both cost and tonnage.

The next risk analysis graph corresponds to the process that contributes most to the total expected values

of Martian mine.

The tonnage planned for Mill2 process show considerable fluctuations from period 8 to 10 and the values

expected show the same periods plus period 7 with high fluctuation.

6 Conclusions

Exercise one contains tables that describe the header for each column and the corresponding column number

from the input files. The availability of tables around the workshop avoids mistakes through the model set.

Also, the correct data classification reduces the amount of memory required for the software. The input data

is also classified according to the type of information it contains. The input data is classified into two major



28 G–2013–65 Les Cahiers du GERAD

380  

 

 

 

through the 7 periods because the risk analysis is performed into a static mine design. As 

expected, the total tonnage mined given variable scenarios of the grade does not change. 

The next risk analysis evaluates the waste extracted, see Figure 31. 

 

 

Figure 31: Risk analysis of the waste tonnage mined and the cost associated. 

The tonnage of the waste fluctuates given 5 geological simulations because the material 

type changes among the different scenarios of the grade. A considerable risk is associated 

with the periods from 8 to 10 for both cost and tonnage.  

The next risk analysis graph corresponds to the process that contributes most to the total 

expected values of Martian mine. 

0

10

20

30

40

50

60

70

80

3 4 5 6 7 8 9 10 11

To
n

n
e

s
M

il
li

o
n

s

Mining Period

Risk Analysis (waste_tonnage.txt)

martianmine0 martianmine1 martianmine2 martianmine3 martianmine4

-60

-50

-40

-30

-20

-10

0

3 4 5 6 7 8 9 10 11

D
is

co
u

n
te

d
 C

a
sh

 F
lo

w
M

ill
io

n
s

Mining Period

Risk Analysis (waste_value.txt)

martianmine0 martianmine1 martianmine2 martianmine3 martianmine4

Figure 31: Risk analysis of the waste tonnage mined and the cost associated

categories: simulated and static. The simulated data is represented by a set of files simulated data and the

static data lies in a single file that contains information that remains constant, regardless of the simulation’s

properties.

Exercise two describes how the risk analysis model is set. The risk analysis model contains the set of

parameters that the software needs to generate risk analysis profiles of a mine design. The workshop has a

focus on tonnage and value by each destination of Martian mine during the setting of the risk analysis model.

The Martian mine data help to illustrate the four steps required to perform the configuration. To set up the

parameters, the user must click the Configure button in the main window. A user interface permits creating

new sets of parameters from scratch or opening the predefined parameters.

Exercise three explains how the risk profiles are displayed as graphs. When the risk analysis process is

finished, the software provides two alternatives to display the risk analysis profiles: one option is to display

graphs directly from the software and the other option is the use of Microsoft Excel. The risk analysis was

performed for the software data. The Martian mine contain 5 material types and 5 destinations. The tones

sent to each destination and the discounted cash flow that produces this decision was evaluated. Twelve risk

profiles were generated, and there were displayed in Microsoft Excel.
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Figure 32:  Risk analysis of the Discounted Cash Flow and tonnage treated in Mill2 process. 

The tonnage planned for Mill2 process show considerable fluctuations from period 8 to 

10 and the values expected show the same periods plus period 7 with high fluctuation. 

6 Conclusions 

Exercise one contains tables that describe the header for each column and the 

corresponding column number from the input files. The availability of tables around the 

workshop avoids mistakes through the model set. Also, the correct data classification 

reduces the amount of memory required for the software. The input data is also classified 

according to the type of information it contains. The input data is classified into two 
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Figure 32: Risk analysis of the Discounted Cash Flow and tonnage treated in Mill2 process
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